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StreamPlayer User Guide

This document is written for anyone using or evaluating StreamPlayer. The StreamPlayer 
product family lets you view high quality MPEG, Windows Media, and H.264 streams (both 
live and on-demand) right from your desktop. The StreamPlayer software is available in two 
versions: StreamPlayer, a view-only component, and StreamPlayer Plus which also allows 
recording and editing of MPEG streams.

It is important to note that the StreamPlayer software you have installed opens different 
types of media files depending on the version you purchase and the licenses you have 
installed. A fully configured StreamPlayer installation can play MPEG-1, MPEG-2, MPEG-
4, WM (Windows Media), and H.264 video streams. Also note that although the terms 
StreamPlayer and StreamPlayer Plus are generally used interchangeably, StreamPlayer Plus is 
actually the fully-featured system that plays and records all VBrick-supported media types.

Organization

Font Conventions
Arial bold is used to describe dialog boxes and menu choices, for example: Start > All 
Programs > VBrick

Courier fixed-width font is used for scripts, code examples, or keyboard commands.

Courier bold fixed-width font is used for user input in scripts, code examples, or keyboard 
commands. 

This bold black font is used to strongly emphasize important words or phrases. 

Folder names and user examples in text are displayed in this sans serif font. 

User input in text is displayed in this bold sans serif font. 

Italics are used in text to emphasize specific words or phrases.

1. Getting Started provides a quick overview of the StreamPlayer user interface.

2. Play explains how to launch a video stream using StreamPlayer.

3. Record explains how to record live video streams. StreamPlayer Plus 
only.

4. Play/Edit Saved Files explains how to play and edit video streams. StreamPlayer Plus 
only.

5. Preferences explains how to set preferences for standard StreamPlayer 
functions.

6. Windows Media Player explains how to Windows Media Player interacts with 
StreamPlayer.

7. Capture Driver explains how to install and use VBrick's "virtual" capture card 
software.



vi Preface
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Chapter 1

Getting Started
Using StreamPlayer

Unless specifically noted, StreamPlayer refers to StreamPlayer WM, StreamPlayer, 
StreamPlayer with MPEG-2 Playback, and StreamPlayer Plus. If you have Windows XP with 
Service Pack 2 installed and are using the Windows Firewall (on by default) you need to 
follow this procedure. The first time that you launch StreamPlayer or StreamPlayer Plus you 
will see an error message. Click Unblock. The next time you run StreamPlayer Plus you will 
not see this message again.

To launch StreamPlayer:

1. Go to Start > Programs > VBrick > StreamPlayer Plus.

The StreamPlayer interface is easy to navigate. The following functions are available from the 
interface.

Play Selecting a video in the Program Info and then pressing the Play 
button plays the video. Double clicking a video from the list in the 
Program Info window also plays the video.

Record StreamPlayer Plus only. Pressing the Record button will launch the 
video window, which allows recording of the currently selected video. 
If a valid StreamPlayer Plus license is not installed, you will be 
prompted to upgrade to StreamPlayer Plus.
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StreamPlayer Differences
Table 1.  Supported Versions

† Plays MPEG-2 if you have an MPEG-2 decoder (e.g. a DVD player) on your computer.
†† Edits MPEG-1 and MPEG-2 streams only.
††† Outputs raw streaming media for third-party applications.

Archive Pressing the Archived Files button lets you play stored video files. If 
StreamPlayer Plus is installed, it also allows users to edit MPEG-1 and 
MPEG-2 video files and FTP video files.

Help Launch the online help system. Minimize or close the application.

Preferences The Preferences button allows the user to modify the StreamPlayer 
default settings.

IP Address IP address of selected stream.

Port Port number of selected stream.

Version Plays License Required

StreamPlayer WM WM, MPEG-1 † No.

StreamPlayer WM, MPEG-1, MPEG-4, H.264 † Yes. Installs automatically.

StreamPlayer with 
MPEG-2 Playback

WM, MPEG-1, MPEG-2, MPEG-4, 
H.264

Yes. See Product CD or 
download from website.

StreamPlayer Plus WM, MPEG-1, MPEG-2, MPEG-4, 
H.264 plus Record, FTP, Edit ††, Capture 
Driver †††

Yes. See Product CD or 
download from website.
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Chapter 2

Play

Playing a Stream
StreamPlayer buffers a certain amount of data before starting a stream to ensure smooth 
playback. Streams with a lower data rate will take slightly longer to start than those with a 
higher data rate. StreamPlayer launches Windows Media Player to play MPEG/Windows 
Media video streams on the PC. There are several ways to play video through StreamPlayer. 

To play a stream in StreamPlayer use one of the following methods:

• Double-click on any Program Title in the StreamPlayer Program Info window to launch 
Windows Media Player. After a short delay (usually less than a second) the selected video 
will appear.

• Highlight the entry in the Program Info window and press the Play button.
• To play an MPEG-1 or MPEG-2 unicast stream or a multicast stream that does not 

appear on the Program Guide, enter the IP Address of the VBrick and Port number in 
StreamPlayer and press Play. 

• To play an RTSP stream, enter an RTSP address in the IP Address field and select Play.
• To play a Windows Media stream, enter an HTTP or RTSPU URL in the IP Address field 

and select Play.

In some cases, you may receive the following error message when attempting to play a video:

0xC00D10B3: Windows Media Player cannot play this file. Connect to the Internet or 
insert the removable media on which the file is located, and then try to play the 
file again.

This problem occurs because Microsoft Windows Media Player automatically tries to detect 
whether the player is connected to a network. If Windows Media Player cannot detect a 
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network connection, and if you try to play online content, you receive an error message. This 
problem may also occur if your player is set to Work Offline.

To force the player to always assume that the player is connected to a network:

1. Go to Tools > Options.
2. On the Player tab, under Player settings, check the Connect to the Internet check box.

See the following Microsoft URL for more information: 

http://support.microsoft.com/default.aspx?scid=kb;EN-US;838101

http://support.microsoft.com/default.aspx?scid=kb;EN-US;838101
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Chapter 3

Record

Recording a Stream
StreamPlayer Plus only. Recording from VBricks using StreamPlayer Plus software may be 
done in a number of different modes with various protection schemes. The recording might 
consist of a single large file or a series of smaller, or batch, files. Batch files may be set up so 
that recent files overwrite earlier ones. Live streams might have the ability to record them 
suppressed or allowed through a password. The recorded stream can be the current stream 
being viewed or a different one. StreamPlayer can also record password-protected streams if 
you know the password. When attempting to record a stream that has been password 
protected, you will be prompted to enter the configured password. There are circumstances 
where you will not be able to record streams. For example, recording is not permitted when 
the application is unlicensed and running in demo mode. Recording can also be restricted or 
entirely disabled by an administrator. Note that Recording and Edit/FTP are currently 
supported for MPEG-1 and MPEG-2.

To record a stream:

1. Highlight the program to record in the Program Information pane.
2. Select the StreamPlayer Plus Record button.

To save a stream:

1. Enter the name of the file to be saved or browse to the location. The default is 
C:\Program Files\VBrick\StreamPlayer Plus\Video\"programinfoname".mpg.
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Password Protection
Enter the password if it is a protected stream. Streams can be password protected in a VBrick 
Appliance in the SAP Transmit or Encoder Configuration section of a VBrick Appliance 
(refer to the VB1000-2000-3000 or VB4000-5000-6000 User Guide for instructions on how 
to configure SAPs). StreamPlayer Plus can record password-protected streams if the 
password is known. When attempting to record a stream that has been password protected, 
the user will be prompted to enter the configured password. Two specific categories shown 
below and set in the VBrick appliance affect StreamPlayer Plus recording. (See the 
StreamPlayer Plus Administrator Guide for more information.)

• norecord – The stream cannot be recorded.
• norecord=<password> – StreamPlayer prompts the user for a password.

MPEG-4/H.264 Hinting
If the stream is MPEG-4 or H.264, the Hint for live streaming box will be selectable. (For 
other MPEG and Windows Media types this box will not be visible). Hinted files contain 
reorganized data that facilitates streaming over the network. If the Hint for Live Streaming 
box is checked, StreamPlayer Plus embeds certain information within the files, making it 
easier for a server to read and send pre-formatted packets. Hinting eliminates server-side 
preprocessing, reducing the CPU load, memory requirements, and the amount of disk access 
on the server.

Note The file name extension for MPEG-1 and MPEG-2, is .mpg. For MPEG-4 and H.264 
it is .mp4. For Windows Media it is .wmv.

Hint for live 
streaming

Hinting a file takes place after the file has been recorded. It is 
recommended that the hinting be complete before the recorded file is 
accessed. If the recorded file will be streamed from a Video on 
Demand server, it is recommended that Hinting be selected.
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Units • Time – Enter the duration in H (hours), M (minutes) and S 
(seconds). The file can be recorded in one continuous stream and 
the length of the recorded file specified by duration in seconds or 
KB. The minimum number of seconds that can be entered is 1; the 
default is 1 minute. An error message will be displayed if there is 
not sufficient disk space for the file being captured. If it is desired 
to simply Start and Stop a record manually, simply set a long 
duration, press Start to begin the recording and then press Stop to 
end the recording. 

• KB – File size = Rate x Seconds/(8X1024).

Enable Batch MPEG-1, MPEG-2, MPEG-4, H.264 only. Recording in Batch Mode 
means that the video is recorded in segments. When Batch mode is 
selected, the video will be recorded in multiple files, each file equal in 
size to the specified batch duration in seconds or KB. The name of 
each file saved will be appended with an increasing number 
(video1.mpg, video2.mpg. . .video99.mpg).   For example, if it is 
necessary to record in batch mode for a total duration of 60 minutes, 
and the batch file duration is 20 minutes, three 20-minute files will 
automatically be created. Batch mode can be used to record video that 
exceeds the Windows 4 GB file size limitation (32-bit), and is 
especially useful when forwarding large video files to a remote Video 
on Demand server or VBStar (VBStar supports Batch Mode, allowing 
the automatic reassembly and streaming of multiple MPEG-2 video 
files.).  An error results if an attempt is made to edit or FTP multiple 
saved files that were not created as in the same batch recording. 
Selecting Batch requires that other parameters be specified in order to 
prevent filling the storage device.

Batch Duration Duration in HH:MM:SS.

Infinite Record Requires a Batch Duration and a Wrap Around Point. This is the 
equivalent of specifying both the length of the clips (in seconds or 
KB) and the total number of clips.

Wrap Around Point This directs the program that after creating the specified number of 
files, StreamPlayer Plus will begin recording over the previous files in 
consecutive order. For example, if the Wrap Around Point is set to 5, 
after recording 5 files, StreamPlayer Plus will continuously overwrite 
the files, beginning at 1.

Recent Next to Wrap Around Point field there is a Recent button. If this 
button is checked then the Wrap Around Point text changes to Save 
Files. In this mode, rather than overwriting files previously recorded, 
the oldest files are discarded and a file with the same name but the 
next consecutive batch number is created. Identification of files by 
number is easier than identification by date. 

Start The video is saved to disk in real time and a progress bar is displayed. 
The recording may be stopped at any time by pressing Stop. MPEG 
files may be viewed, e-mailed, FTPed, and/or edited.
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Disk Storage Requirements
Stream recording requires significant disk space. One minute of captured video/audio from a 
1.2 Mbps stream (a typical MPEG-1 stream or a high bit rate MPEG-4 stream) requires 
approximately 9 MB of disk space. By comparison, 1 minute of captured video/audio from a 
5.5 MB per second stream (a typical MPEG-2 stream) requires approximately 40 MB of disk 
space. Be sure to have enough disk space free for any intended capture. The amount of disk 
storage required depends on the bit rate and the recording time. A rough rule is to allow 1 
GB per hour for MPEG-1, 2.5 GB per hour for MPEG-2, and 500 MB per hour for MPEG-
4.

System 
Stream Rate 
(Bits/sec)

System 
Stream Rate 
(Bytes/sec)

Storage Required 
per Sec.
(Kbytes)

Storage Required 
per Min. 
(Mbytes)

Storage Required 
per Hour (Mbytes)

1,200,000 150,000 150 9 540

1,800,000 225,000 225 14 810

2,000,000 250,000 250 15 900

2,500,000 312,500 313 19 1,125

2,800,000 350,000 350 21 1,260

Note The Total Bit Rate in StreamPlayer Plus will be different than what is shown in 
MPEG-4 settings. The actual rate may be slightly higher than what is shown in 
StreamPlayer Plus (due to overhead).
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Chapter 4

Play/Edit Saved Files

Playing Saved Files
StreamPlayer Plus can play most MPEG and Windows Media files, and video can be played 
directly on a PC after recording a stream to disk. Select the Archive button on StreamPlayer 
to open the video file location. A file browser makes it possible to select, open and play a file. 
Recorded MPEG and Windows Media video files placed on a file server are available for on-
demand viewing using StreamPlayer software. Files can also be transferred to a VBrick Video 
on Demand server (for MPEG files) or a Windows Media video on demand server (for 
Windows Media files) providing additional functionality.  The default storage location for 
archived files is C:\Program Files\VBrick\StreamPlayer Plus\Video. Once a video is 
selected, it can be played, edited (StreamPlayer Plus only), and/or transferred via FTP 
(StreamPlayer Plus only). While playing video, use Seek, the slider bar at the bottom of 
Windows Media Player, to control the location in the file.

Playing Batch Files
It is possible to play either a single recording or batch files. If there are multiple batch files 
recorded during the same batch record session or if the batch files recorded during different 
sessions are the same type and were recorded at the same bit rate, they can be seamlessly 
viewed by holding down the <shift> key. To select non-contiguous files, select each file with 
the right mouse button while holding down the <control> key and selecting Open.

Edit/FTP
StreamPlayer Plus only.  After you select the file to be played, the Edit/FTP dialog box 
appears in StreamPlayer Plus for MPEG-1 and MPEG-2 files. Selecting No brings up the 
Windows Media Player and the file or files will automatically load and play. Selecting Yes for 
brings up the Edit Clip dialog box. Edit and FTP are supported for MPEG-1 and MPEG-2 
video files. MPEG-4 and Windows Media files cannot be edited or FTPed. An error results if an 
attempt is made to edit or FTP multiple saved files that were not created as in the same batch 
recording. To edit Windows Media files, use Microsoft Windows Movie Maker or a similar 
product.

Note Playing multiple batch files is supported for MPEG-1 and MPEG-2. MPEG-4, H.264, 
and Windows Media files can be highlighted and played individually but not as a 
group.

http://www.microsoft.com/windowsxp/downloads/updates/moviemaker2.mspx
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Editing Files
The Archive Editor allows selecting a portion of the MPEG-1 or MPEG-2 video file for 
immediate playback, and permits saving this clip as a new file. The editor is not frame-
accurate; rather, it indicates how many seconds from the start of the file that the edited 
section begins, and how many seconds from the start of the file until it ends. 

To edit an MPEG-1 or MPEG-2 video file:

1. After selecting an MPEG-1 or MPEG-2 video file, put the viewer in pause mode by 
starting and then pausing the clip within the Edit Clip window. 

2. Next, select Start Transmit and move the slider to the point in the video where the clip 
will start. 

3. Select End Transmit and move the slider to where the clip will end.
Note: The Start and End times are displayed, as well as the duration of the clip. (The Clip 
Editor displays an error if the times are entered incorrectly, such as the start time after 
the end time or vice versa). 

4. To play the new clip, press the Play button. Keep creating clips until the one that’s played 
is satisfactory (this button is grayed out while paused). 

5. To save the clip, use Save As and enter a file name (this button is grayed out while 
paused). 

6.  Press Start to save the clip to disk as a new MPEG-1 or MPEG-2 file.

Moving Files via FTP
StreamPlayer Plus has a built-in file transfer capability that allows an MPEG-1 or MPEG-2 
saved file to be instantly transferred to a FTP server. Selecting FTP from the Archive Viewer 
brings up the FTP dialog box as shown.
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After entering the Login name and Password, you can to browse the contents of the FTP 
server by selecting the Browse button. This is convenient for determining what video files 
may already exist on the server.

Local File Name The full path name of the file to transfer. The default is the current 
file.

Start/Stop Bytes If a start and stop position have been selected in the Archive Viewer, 
this is the starting and ending position in bytes that will constitute the 
file to be transferred. In other words, the edit can be FTPed without 
saving it locally.

Save to Remote 
File Name

The full path name where the file will be located on the FTP server.

Remote Address The name or IP address of the FTP server.

Login Name The FTP user name.

Password The FTP password.
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Chapter 5

Preferences
Setting Preferences

Note that StreamPlayer always uses the latest Windows Media Player installed on your 
computer. You cannot choose a specific player.

General

Computer 
resources allocated 
to Windows Media 
Player

This setting allocates computer video resource preferences. 
Depending on the computer environment, StreamPlayer may require 
higher priority than other non-real time processes that may be running 
on the desktop. The computer Resource Allocation (priority) may be 
set for Normal, Above Normal, Highest, or Critical for MPEG1, 
MPEG2 and MPEG4/H264 decoding. If performance problems are 
experienced with either video playback or recording, set Resource 
Allocation to a higher level. The defaults are MPEG1 normal, 
MPEG2 highest, and MPEG-4/H264 above normal.

Closed Captions This selection enables or disables closed captions and determines how 
they will be displayed. Enabling Closed Captions in the StreamPlayer 
Preferences menu generally enables closed captions in Windows 
Media Player. Overlay Closed Captioning puts Closed Captions on top 
of the video. This is particularly beneficial if the video is viewed full 
screen (or if you want TV-like behavior). If not checked, closed 
captions will be displayed below or beside the picture.
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Custom Columns

MPEG-4/H264
Due to the lower bandwidth nature of MPEG-4 and H.264 streams, StreamPlayer offers 
several parameters to tune the receiving of these streams.

IGMP IGMP (Internet Group Management Protocol) is used to receive 
multicast streams from a network. The latest version of this protocol 
(version 3) supports Source Specific Multicast (SSM). In an SSM-
enabled environment, multiple streams can be sent to the same 
multicast address. Decoders can distinguish between streams based on 
their source IP address. This option is available only on Windows XP 
machines and is supported for 232.x.x.x address space. When this 
option is on, StreamPlayer can playback 232.x.x.x. streams that are 
coming in on the same multicast address.

Surround Sound Check Disable Surround Sound to fix a problem on certain Windows 
Media Player versions where mono audio is not heard. You must have 
Administrator privileges to disable Surround Sound.

Client Multiple 
Monitor Setup

Check Disable VMR9 if StreamPlayer crashes or hangs when you are 
playing a live stream on a second monitor. 

Columns The default is for Program Name only to be displayed in the 
Program Info area. To view other available information, select the 
Custom Columns Tab. Other possible selections include IP 
Address, Port, Source IP, etc. Use the Column buttons on the 
Settings Box to add or remove columns. The display order can be 
changed using the Sort By buttons.

Filters Filters can be used to narrow the selections from the available 
fields. If the word "Unit" is entered, only VBricks with the word 
"Unit" in the Program Info field will appear. If "239" is entered in 
IP address, only those VBricks with "239" in the IP address field 
will appear. The Filters field is not case sensitive. It can also 
search for a partial name. For example entering "Science" in the 
program name field displays programs with names “SCIENCE” 
and "ScienceClass." Also, multiple search entries can be input by 
separation with a semi-colon. For example, entering "sales;HR" 
will display programs"company sales" and "company HR".
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Categories
StreamPlayer supports Categories. Categories allow the sender to restrict the ability of 
network users to see a stream announcement the network. For example, a corporation can 
broadcast financial, sales and engineering information from separate VBrick appliances onto 

Buffer Size Sets the buffer size which provides a more smooth viewing experience 
if there is packet loss. Default (and minimum setting) is 200 
milliseconds for UDP Playback (typical on a Local Area Network) and 
2000 milliseconds (2 seconds) for TCP Playback (typical on the 
Internet).

MPEG-4 Decoder There are several settings that can improve the video quality of 
MPEG-4 streams by post processing the video signal after it has been 
decoded. However, this increases CPU utilization substantially. 
Deringing and Deblocking are resource intensive and are not 
recommended unless the PC has a 2.0 GHz, or higher, processor. On 
lower end machines, enabling Deringing and Deblocking may degrade 
video quality.

Enable Deringing Corrects for certain motion artifacts.

Deblocking Smooths the video frame by smoothing artifacts inherent to the digital 
compression process.

MPEG-4/H264  
RTSP Streams

StreamPlayer Plus can receive MPEG-4/H264 streams via several 
methods in order of efficiency – UDP, RTSP Interleaving, or HTTP 
tunneling. When Automatic is chosen StreamPlayer Plus will try 
different protocols to establish the best connection. In some cases, for 
example, if you know you cannot receive UDP streams because of 
firewall issues, you may want to define the method StreamPlayer tries 
to connect because the automatic method can cause up to several 
seconds of delay. The port can also be modified, but this is not 
recommended, unless you know that the port on the VBrick or Video 
on Demand server that is sending the video has also been changed.
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a common network. A Category known to the sender and recipient protects the stream 
announcement from being seen by others. A Category entered in the originating VBrick 
product can be matched in the StreamPlayer application to permit listing of the stream. The 
field is set in the Configuration: Encoder > Encoder > Announce section of the VBrick 
Appliance. To receive the stream, the same Category keyword must be entered under the 
Categories tab of StreamPlayer. 

To enter a Category, enter the category name and select Add. Once a category is added, 
StreamPlayer will receive streams that are transmitted from the VBrick with the same 
Announcement (SAP) category entry as well as streams not sent with a Category. For more 
information about categories, see the StreamPlayer Administrator Guide. 

Program Announcements
The addresses on this window apply to all appliances. They are rarely changed and should not be 
modified unless specifically instructed to by VBrick Systems or by a VBrick Certified Partner.

Note StreamPlayer displays all programs in which a VBrick appliance is not advertising a 
category. To filter a stream, the VBrick product originating the stream must be 
configured with a category.

Server Announce
Address

IP Address and Port from which Announcements will be received 
from VBricks. The Server Announce address is the address on which 
Multicast announcements will be received.

RTSP Server Anno
unce Address

Address on which the VBrick’s transmit RTSP server announcements. 
In order to view programs in the Program Info screen, the addresses 
here must be set to the same address and port to which the VBrick 
appliance is transmitting.

Program Listings • Stream Watch – The source filter periodically sends messages to 
the StreamPlayer. If the StreamPlayer does not receive these 
messages for this predefined time period in seconds, the 
StreamPlayer restarts the player.

• Network Interface Card – If your computer has more than one 
interface card, specify which NIC will receive the stream.
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Chapter 6

Windows Media Player
StreamPlayer uses the latest version of the Windows Media Player installed on your computer 
to play a selected stream. (Windows Media Player can be downloaded from the Microsoft 
website if it isn't already installed on your PC.) Once a stream is launched with Windows 
Media Player, you can select various Windows Media Player options. However, it is important 
to note that different versions of the Media Player have different capabilities and options. 
Windows Media Player options are also in different menu locations on different versions of the player. 
Some Media Player Options relevant to StreamPlayer Plus are shown on the File, View, and 
Play menus.

Windows Media Player Options
Once a stream is launched with Windows Media Player, some Windows Media Player options 
can be utilized. Only some Media Player options are specifically included in the operation of 
StreamPlayer. The Windows Media Player Options important to StreamPlayer operation are 
File , View, and Play. If the Media Player Options are not visible, select the small icon at the 
top left of the viewing window. The location of options settings vary in different Media 
Player versions. Use Media Player Help to locate location of settings in different versions.

http://www.microsoft.com/windows/windowsmedia/default.aspx
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File Options

Launching a Stream from Windows Media Player

This applies to entering MPEG-1 and MPEG-2 streams. Open does not work with RTSP on 
Windows Media Player 7.1 and 9. The address on those versions can be entered directly into 
the IP Address window on StreamPlayer. The multicast address and port number may be 
entered directly in Media Player without launching StreamPlayer by using File > Open, and 
typing in the IP address and port from which the stream originates. For examples of 
additional functionality, see "Source Filter Tags" in the StreamPlayer Admin Guide.

To launch a stream (from Windows Media Player) without using StreamPlayer:

1. Launch Windows Media Player.
2. Select File > Open URL.
3. Enter vbricksys://ip=address&port=number (replace the address and port number with 

the IP address and port of the stream). 
4. Enter OK to play the stream. Note: This method does not provide the display of the 

Program Title, Author, or Copyright information.
5. If there are several NICs installed on the PC, the interface that StreamPlayer Plus uses 

can be specified by including the interface IP address:
vbricksys://ip=225.1.1.1&port=4444&interface=123.456.789

6. To play a MPEG-4 RTSP stream (unicast) type:
vbrtsp://<ip address of server>/<program-name> 

7. To play a MPEG-4 multicast stream type:
vbhttp:// <ip address of server>/<path to the SDP file> 

8. To play a Windows Media stream type:
http://<ip address of server>/<path to .nsc file> 

http://<ip address of server>/<path to ASX file> 

http://<ip address of server>/<program name> 

rtspu://<ip address of server>/<program name> 

View Options
Most StreamPlayer Plus options are set under the Preferences tab of the StreamPlayer Plus 
application but others can be set in the menus Windows Media Player. The View options 
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make it possible to resize the display, choose a skin, and set other display options. View 
options include the following.

Play Options
Note that you can control video using the Play and Volume options. Captions must be turned 
on in Windows Media Player (indicated by a check mark) and in StreamPlayer under 
Preferences in order to be displayed. If Closed Captions is selected in StreamPlayer, it will be 
automatically selected in Windows Media Player. Captions are located under Now Playing 
Options.

Full Mode Shows player in standard consumer mode.

Skin Mode Shows player in selected skin (for example Corporate).

Full Mode Options Controls the appearance of menu and task bars.

Now Playing Options Show/hide title, playlist, etc.

Statistics Displays frame rate selected and actual. Statistics does not display 
the selected and actual frame rate when Closed Captioning 
Overlay on Video is selected in StreamPlayer Plus Preferences. 
Statistics are available for all appliances. Statistics are not available 
if Media Player 7.1 is used. 

Full Screen Alt + Enter. 

Video Size Zoom to 50%, 100%, or 200%).

Note When Closed Captioning Overlay on video is selected in the StreamPlayer Plus 
Preferences, Statistics does not display the selected and actual frame rate. Statistics are 
not available if Media Player 7.1 is used.
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Chapter 7

Capture Driver
MPEG-1 and MPEG-2 streams only. VBrick's Capture Driver is a virtual video capture card. 
The Capture Driver software acts similar to the way hardware capture cards work, with the 
added benefit that it can receive video originating from a VBrick. The Capture Driver 
receives the MPEG video and outputs AVI or DV video; therefore, all existing software 
programs that capture or manipulate video and audio may be used with VBrick appliances. 
Video sources may be anywhere on the network. Unlike hardware capture devices, the 
connection does not require a physical connection to a computer through an analog coax or 
Firewire cable. Also, any number of video sources is possible. There is no limit imposed by 
the number of physical audio/video inputs available on the computer. Since the process is 
digital, there is no conversion loss. The capture driver enables frame capture, motion 
detection, automatic e-mail notification, logging, and more, for security and monitoring 
applications. Video can be captured, using an editing program, in multiple formats, including 
AVI, DV, etc. and edited directly using a familiar editing tool. Video can also be re-encoded 
from MPEG format to other formats that might be more suitable for the application.

Overview
Once installed, it appears in the Window's Multimedia Control Panel like a physical capture 
card. Any video application that allows the selection of an installed audio/video device will 
provide VBrick as a choice for video input. Selecting VBrick Video Capture permits choosing 
a physical VBrick appliance through a Program Guide. Upon selection, the Capture Driver 
processes the video stream, identifies it as MPEG-1 or MPEG-2, and decodes it. The 
decoded audio/video is delivered to Windows via a standard DirectX interface, just like a 
local physical capture card. The video software does not know or care that the audio/video 
source may be miles away—delivered to the computer as MPEG over IP—it acts like a local 
video capture card.

Installing Capture Driver
By default the VBrick Capture Driver is not installed with the installation of the StreamPlayer 
Plus software. In order to install the Capture Driver software, rerun the 
SetupStreamPlayer_5_x_x.exe (the software cannot be installed from Add or Remove 
Programs). A maintenance window will appear asking if you want to Modify, Repair, or 
Remove, Choose Modify and press Next. The Add/Remove Components dialog box will 
display.
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Check Capture Driver and press Next. If you have previously installed Capture Driver then a 
popup dialog box will appear asking you if you wish to remove the old version and restart 
your PC. You must choose Yes to install the software. Choosing No will cancel the install. If 
you select Yes, an additional popup dialog box will appear asking for a license file. A License 
file is required for installation of StreamPlayer Plus. The license file, ending with a .lic 
extension, is distributed on the Product CD or by e-mail. Press Yes to install the license file. 
Browse to the location of the License File and select it, then select Open; or double-click on 
the file name. The Capture Driver will be installed on your system.

Verifying Installation
Capture Driver can be installed on Windows 7, Vista, or Windows XP. The following 
procedure explains how to verify the installation using Windows XP. 

To verify installation using Windows XP: 

1. Go to Start > Control Panel.
2. Select System by double clicking it, or use the right mouse button and Open.
3. Select Hardware.
4. On the Hardware menu, under Device Manager, select Device Manager.
5. Select Sound, Video and game controllers by double-clicking on that line entry.
6. Double-click Legacy Video Capture Devices.
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7. The Properties tab shows VBrick Video Capture. The General tab reports Device Status. 
8. Under Sound, Video and game controllers, double-click on Legacy Audio Drivers.
9. Select the Properties tab. Double-click on Audio Devices. The Audio for VBrick Video 

Capture will display. The General tab reports Device Status.

Using a Captured Stream
To use Capture Driver:

1. Open the third-party software for which you want to capture video or audio.
2. When prompted for the input device for the capture, select VBrick Video Capture and/or 

Audio for VBrick Video Capture. The Capture Driver will capture the VBrick stream and 
allow the third-party software to act on it.
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